
 

 

 

Township of Brock 

Alternate Formats Policy 

1. Statement of Organizational Commitment 

The Corporation of the Township of Brock is committed to providing information and 
communication about their goods, services or facilities in a manner that is accessible to 
persons with disabilities. 

2. Background 

The Accessibility for Ontarians with Disabilities Act (AODA) was proclaimed in 2005 with 
the stated intention to “achieve accessibility for Ontarians with disabilities with respect to 
goods, services, facilities, accommodation, employment, buildings, structures, and 
premises on or before January 1, 2025.” In order to achieve this vision, the Provincial 
government has issued five set of standards under AODA: customer service, 
transportation, communication and information, employment, and built environment.  

As part of the ongoing requirements under the AODA and the Integrated Accessibility 
Standards Regulation (IASR), Ontario Regulation 191/11, an obligation addressing the 
provision, upon request, of corporate documents in alternate formats was developed. If 
an employee or member of the public requests alternate formats of municipal 
information or communication, the municipality must attempt to develop and deliver 
alternate formats of the requested municipal information or communication in a timely 
manner that takes into account the person’s accessibly needs and at a cost that is not 
more than the regular cost charged to other persons. 

3. Purpose 

The purpose of this policy is to document how the municipality will, upon request, 
provide or arrange for the provision of accessible formats and communication supports 
for an employee or the member of the general public with a disability.   

4. Scope and Responsibility 

This policy applies to all Township of Brock employees and persons with disabilities. 
This policy also applies to all information and communications produced by the 
municipality for the release to the public, staff, or volunteers whether produced in-house 
or on behalf of the municipality. This policy does not apply to unconvertible information 
and information that the municipality does not control directly or indirectly through a 
contractual relationship. 

Page 1 of 4 



 

 

 

 

The CAO & Municipal Clerk is responsible for the overall implementation and 
enforcement of this policy. 

5. Definitions 

“Accessible formats” may include, but are not limited to large print, recorded audio, 
electronic formats, and other formats useable by persons with disabilities. 

“Barrier” as defined by AODA, means anything that prevents a person with a disability 
from fully participating in all aspects of society because of his or her disability including 
a physical barrier, an architectural barrier, information or communication barrier, an 
attitudinal barrier, a technological barrier, or a policy or practice. 

“Communications” means the interaction between two or more persons or entities, or 
any combination of them, where information is provided, sent or received. 

“Disability” as defined by AODA, means: 

a) Any degree of physical disability, infirmity, malformation or disfigurement that is 
caused by bodily injury, birth defect or illness, and, without limiting the generality 
of the foregoing, includes diabetes mellitus, epilepsy, a brain injury, any degree 
or paralysis, amputation, lack of physical coordination, blindness or visual 
impairment, deafness or hearing impediment, muteness or speech impediment, 
or physical reliance on a guide dog or other animal or a wheelchair or other 
remedial appliance or device; 

b) A condition of mental impairment or a developmental disability; 

c) A learning disability, or a dysfunction in one or more of the processes involved in 
understanding or using symbols or spoken language; 

d) A mental disorder; or 

e) An injury or disability for which benefits were claimed or received under the 
insurance plan established under the Workplace Safety and Insurance Act, 1997. 

“Employee” means any paid employee, including, but not limited to, full-time, part-time, 
paid apprenticeships, and seasonal employees.   

“Information” means data, facts and knowledge that exist in any format, including text, 
audio, digital or images, that convey meaning. 

“Municipality” means the Corporation of the Township of Brock. 

“Unconvertible Information” means information or communications that is not 
technically feasible to convert and/or the technology to covert the information or 
communications is not readily available. 
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6. General Policy 

6.1 Development of Township Documents 

All Township of Brock documents shall be created in an accessible format using the 
“Township of Brock – Guide to Accessible Documents” attached hereto as Appendix A. 
Furthermore, templates for letters, reports, memorandums, minutes, agendas, and job 
postings have been developed for use by all Township staff.  

All municipal documents that the Township controls directly or indirectly shall feature the 
“Alternate Formats” clause: 

“This document is available in alternate formats upon request. 
Please contact the Clerk’s Department at 705-432-2355.” 

6.2 Requests for Alternate Formats 

An employee or member of the public shall make requests for Alternate Formats 
through the “Request for Document in an Alternate Format” attached hereto as 
Appendix B.  The Clerk’s department shall consult with the department from which the 
document originated and the person making the request to determine their accessibility 
needs. The request shall be honoured in a practical manner depending on: 

I. the media chosen; 
II. the size and complexity of the document; 
III. the quality and source of the documents; 
IV. the feasibility of the request, including cost; and 
V. the number of documents to be provided. 

6.3 Unconvertible Information 

If it is determined that information or communication are unconvertible, the Clerk’s 
department shall provide the person requesting the information or communication with: 

I. an explanation as to why the information or communication is 
unconvertible; and, 

II. a summary of the unconvertible information or communication. 

6.4 Conversion to Alternate Formats 

Conversion to alternate formats shall be processed in-house wherever possible. If a 
request cannot be processed in-house, the municipality will explore external options for 
the conversion. 

If it is determined that the format requested is not feasible, other alternate methods of 
providing the information or communication shall be explored. The alternate method 
shall attempt to meet the needs of the person making the request and be agreed by 
both parties. 
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6.5 Meeting Requests in a Timely Manner 

All requests for alternate formats and communication supports will be provided by the 
municipality in a timely manner that takes into account the person’s accessibility needs 
and the timeliness of the request. 

6.6 Providing Information at No Additional Cost 

The municipality will provide alternate formats and communication supports at a cost 
that is not more than the regular cost charged as per the Township of Brock Fees By-
Law. 

6.7 Notification 

Public Notification 

The municipality will notify the public of the availability of alternate formats and 
communication supports on all Township documents and the Township website.  

Employee Notification 

The municipality will notify all employees of the availability of alternate formats and 
communication supports during staff training. 

7. Administration 

The Clerk’s Department will receive and review all “Request for Document in Alternate 
Format” forms and forwarded them to the department in which the requested document 
originated from for consultation. The Clerk’s department will respond to all requests for 
alternate formats. 

*Adopted by Resolution No. 4-7 at the September 22, 2014 Protection to Persons & Property 
Committee 
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Appendix A 

Township of Brock Guide to 
Creating Accessible 

Documents 

October 2018 

This document is available in alternate formats upon request. 
Please contact the Clerk’s Department at 705-432-2355. 
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Introduction/Background 
The Township of Brock is committed to promoting, encouraging, and providing an 
accessible community and ensuring equality for all in the Township of Brock. 

The Accessibility for Ontarians with Disabilities Act (A.O.D.A.) was passed by the 
Ontario Legislature in 2005. The overall goal of the A.O.D.A. is to provide for the 
development of minimum standards in order to achieve accessibility for Ontarians with 
disabilities with respect to goods, services, facilities, accommodations, employment, 
buildings, structures and premises on or before January 1, 2025. In order to achieve this 
vision of a barrier-free Ontario by 2025, the Government has issued five sets of 
standards under A.O.D.A.: customer service, transportation, communications and 
information, employment, and the built environment. 

The Integrated Accessibility Standards (I.A.S.R.), Ontario Regulation 191/11, 
establishes the compliance framework for obligated organizations and is based on the 
Ontario Human Rights Code. It establishes accessibility standards for: Information and 
Communications, Employment, Transportation and Built Environment. 

The Information and Communications section of the I.A.S.R. seeks to provide persons 
with disabilities enhanced access to information in accessible formats, upon request. 

Statement of Organizational Commitment 
The Corporation of the Township of Brock is committed to promoting, encouraging, and 
providing an accessible community which ensures equality for all by meeting the 
accessibility needs of persons with disabilities in a timely manner and developing, 
implementing, and maintaining policies governing how the municipality achieves and will 
achieve accessibility requirements of the Integrated Accessibility Standards Regulations 
(I.A.S.R.) under the Accessibility for Ontarians with Disabilities Act (A.O.D.A.). 

More than Compliance 
Accessibility is not just a matter of legal compliance. 

Implementing Accessibility Standards will foster inclusiveness and enhance access to 
municipal goods, services, and facilities in a way that respects the dignity and 
independence of persons with disabilities. 

This Guide to Accessible Documents aims to produce website ready, user-friendly 
documents for all stakeholders and municipal staff, including persons with disabilities. 
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What does it mean to make information accessible? 
Accessible information means considering the needs of persons with disabilities. 

 When you create new information, think about what might help someone who 
has low vision, hearing loss, or a learning disability to understand it; 

 To make your existing information more accessible, recreate it in an accessible 
format. For example, use large print for someone with vision loss; 

 You can also help someone to understand the information. For example, use 
written notes to communicate with someone who is deaf. 

Readability should be the first step in making administrative documents accessible 
to everyone. 
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Font, Design and Accessible Formats 
Use Appropriate Font Family 

Avoid complicated, decorative or handwriting fonts. 

Choose “Sans-Serif” fonts as opposed to “Serif” fonts. 

“Sans-Serif” fonts are characters that do not have small strokes at the ends, such as: 
Verdana or Arial. 

These fonts have easily recognizable upper, lower-case, and numerical characters. 

“Serif” fonts have decorative strokes at the end of the characters making it difficult to 
read, such as: Times New Roman. 

Arial This font is accessible 

Garamond This font is not accessible 

Monotype Corsiva This font is not accessible 

Tip: The Township’s standard font family is Arial. 
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Use Appropriate Font Size 

Make text large, preferably between 11 and 18 point. 

The size of the font is a fundamental factor in legibility. 

A font size of 10 point and smaller is not accessible and should be avoided where 
possible. 

Font size 11 is the Township’s standard for main body text. 

A minimum font of size 16 is the Township’s standard for presentation documents. 

Font size 10 Not accessible & should be avoided where possible 

Font Size 11 Township’s standard for main body text 

Font Size 14 Township’s standard for main headings 

Font size 16 Township’s standard for large print 

Note: Font size varies between font families. This guide is based on the Arial font. If 
using sans-serif fonts other than Arial, use Arial as the base for determining appropriate 
font size. For example: 

Arial, font size 11 Township standard for main body text 
Calibri, font size 13 Calibri 13 is similar in size to Arial 11 
Verdana, font size 11 Verdana 11 is similar in size to Arial 11 

Use Bold for emphasis, not italics or underlining 

Avoid italics and underlining, to improve readability. 

Italic fonts are more difficult to read than regular fonts, mainly due to the output of 
angled characters on a digital screen that has a poor resolution. There may be 
exceptions to using italics when required to meet standard formatting, such as citations 
in legal documents. If the font is very large, italics may be legible, but as a general rule, 
avoid italics where possible. 

Underlining used for emphasis interferes with lower case letters and should be avoided 
for emphasis. Only use underlining when describing internet links, such as email 
addresses and web pages. In this application, use the international standard of a blue 
font. For example, www.townshipofbrock.ca. 
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Avoid sentences in all UPPER CASE letters 
A sentence written with a combination of upper and lower case letters is easier to read. 

The ascenders and descenders found in lower-case letters provide word shape which 
cause mental reading clues to speed up the process of reading. Sentences written in all 
upper-case letters do not benefit from these clues and are more difficult to read. 

In some instances, it may make sense to use all upper case, such as titles with a 
maximum of two words or when text is being used as a graphic image and is not 
intended to be read. In both of these examples, there is no benefit to having the mental 
reading clue. 

Upper case can give the impression of shouting to the reader and therefore should 
always be avoided where possible. 

If the intent is to convey a shout, use an exclamation point as per proper grammar. 

Acronyms 

With acronyms, it is best to have a period between each letter. Periods allow screen 
readers to properly interpret the text as an acronym and not a word. For example, the 
acronym for Accessibility for Ontarians with Disabilities Act is A.O.D.A. If several 
acronyms are used often throughout your document, consider including a glossary of 
terms. 

AODA 

A.O.D.A. 
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Abbreviation 
An abbreviation is a shortened version of a word or phrase. Abbreviations should 
always be spelled out the first time it is used in a document with the shortened version 
following in brackets. 

Example: Street (St.) 

Another example, is the abbreviation of the word “number” which is often listed as “No.”. 
Keep in mind that the letters “no” are in the opposite of “yes”. A person using an 
assistive program would not customize their computer to have the letters “no” read to 
them as number. 

Using the #, will enable assistance programs to hear it is a number. The hashtag (#) is 
on the keyboard, and is commonly used to refer to a number. 

Abbreviations Can Be Confusing 
What one would you use? 

1. Telephone Number – most preferred 

2. Telephone # - next preferred 

3. Telephone No. – the abbreviation No. is identical to the word in the English 
dictionary no (opposite of yes) and is not recommended to use. 

What one would you use? 

1. For example? 

2. e.g.? 

It is always best to spell out the words. However, if you need to abbreviate, use “e.g.” 
based on the Canadian Press Stylebook. 
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Use Appropriate Text Alignment 

Align text to the left margin. 

Aligning text to the left margin makes it easier to find the start of the 
next line and keeps the spacing between the words even. 

Centre alignment is not accessible. 

Justified alignment is not accessible as it causes uneven spaces 
between words. 

Where images are used with text, align the image to the left of the page with the text 
directly above or below. Alternatively, align the image to the right of the page with the 
“Square” text wrapping option and keep the text aligned left. 
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Use Smart Headings, Paragraph and Spacing Tools 

Use Styles to create a reference structure and help users navigate the document. 

Microsoft Office 

 Use the “Styles” tool to quickly apply formatting choices to headings and 
paragraphs. 

 Headings create structure within a document and assist with accessibility, once 
converted to a Portable Document Format (PDF). 

 A Heading 1 (H1) would be the main topic of your document or section of your 
document. 

 A Heading 2 (H2) would be a subsection of the Heading 1. 

 A Heading 3 (H3) would be a subsection of the Heading 2. 

 A Title style is typically used on a cover page. 

 Benefits are: 

o Screen readers can more easily identify and navigate sections; 

o Increased readability; 

o Formatting is consistent throughout the document; 

o A table of contents with links to document sections can be automatically 
generated, as formatted in this document. 

Tip: The Township’s standard headings are below. 

 Heading 1 (H1) – Arial, 16 point, bold, 12 spaces before and 6 spaces 
after the text is recommended. 

 Heading 2 (H2) – Arial, 14 point, bold, 6 spaces before and 6 spaces after 
the text, is recommended. 

 Heading 3 (H3) – Arial, 12 point, bold, 6 spaces before and 6 spaces after the 
text, is recommended. 
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Colours 
Colour is often what makes a marketing piece stand out. However, when creating 
accessible documents, be aware of the correct and/or appropriate colour choices. 

The easiest text colours to read are black and white. 

Some people prefer a high-contrast background, such as black font on a white or yellow 
background. The same is true for the opposite white or yellow text on a black 
background. Any text in a filled box should be bold face. 

Contrast 
The better the contrast between the background and the foreground, the more legible 
the document will be. Black text on a white background provides the best contrast 
and is the easiest to read. 

With a coloured background, ensure the text is still easily visible by bold-facing the font. 

Try to avoid busy or confusing background images, as it makes reading the test difficult. 
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Use Informative Alternative Text for all Graphics 
Add a short description to all graphics inserted into a document. This includes, but is not 
limited to, logos, pictures, charts, informative images and links. 

An “Alt tag”, or alternative text, is a brief description of any graphic that is inserted into a 
document. It can be read by a screen reader to allow someone with a vision disability to 
understand what the graphic is. 

When software does not support the display of the images or when the user has chosen 
not to view images the “Alt tag” is displayed in place of the image. 

To add an ALT tag or ALT text to an image, right click the image and select Edit Alt 
Text. Add a title and description of the image. 

To add ALT Text to a chart, right click the chart and select the ALT Text tab and the top 
right hand corner of the pop up. Add a title and description of the chart. 
Logos 
A logo should have alternative text. For the Township of Brock logo, the alternative text 
should be: Township of Brock logo. 

Images 
Any photos or graphics used must have copyright permission. This means that you 
have the right to use them. Do not use images pulled via Google or the Internet. 

Provide information that describes the pictures function. 
Charts 
If the information in the chart is located within the document, the alternative text can 
give a brief description and state “for more information see page XX of this document.” 
If the chart information is not found within the report, you should provide a description of 
the content of the chart. 

Informative Images 
Informative Images are graphics that are used to illustrate a concept, for example a 
phone symbol. The alternative text should convey the information presented by the 
image “phone”. 

Links 
The link to a document would have alternative text describing the link and indicating the 
size of the document. For example “Guide to creating accessible documents (PDF 
1,245KB)”. 

If the link redirects the user, the alternative text should indicate this. For example, “this 
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link will take you to the Township of Brock’s accessibility webpage”. It is important to 
keep the actual link contained on one line to prevent it from being separated to two lines 
after converting it to PDF. 

Use the word ‘select’ versus ‘click’ as some users do not use a mouse. 
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Use Appropriate Leaders 
Avoid dot leaders that are often used in a Table of Contents. 

What is acceptable? 

Dot Leader ……………………………………… No 

Solid line leader _______________________ Yes 

No leader     Yes 
*provided there is enough space between the lines 

Use Page Numbering 
Add automatic page numbering using the Header and Footer tool. 

Numbering the pages of a document helps readers navigate the document and 
reference content correctly. Having the numbering listing as “Page X of Y” is better than 
having Page X located on the bottom right corner. For example, instead of having Page 
3 in the footer of the document, have Page 3 of 10. 
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Use Lists 
Use the built-in lists available within the programs. Not all assistive devices and 
technologies recognize all symbols. For example, if using any of the symbols in the 
Wingdings category, some assistance devices and programs will say wingdings instead 
of the symbol you selected. 

Bulleted Lists 
Use bulleted lists if the information is a related set of points. Bulleted lists should being 
with a colon. Each point in the list should end with a period. 

Sewage: 

 Sewage treatment. 
 Pumping stations. 
 Sewer lines. 

Numbered Lists 
Use numbered lists if the information is needed to be in order as in the example below. 
Numbered lists should have a period at the end of each one, not a semi-colon. Avoid 
using Roman Numerals. 

Six Stages of the Recruitment Process 

1. Apply online. 
2. Application screening. 
3. Selection process. 
4. Welcome. 
5. Reference check. 
6. Offers of employment. 
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Use Standard Date Format 
The international standard for date format is yyyy-mm-dd. 

Dates are formatted differently across the world, which can be confusing to readers and 
cause misunderstandings. 

The simplest way to write dates is to spell out the month portion of the date. The 
moment the month is spelled out, the date is no longer misinterpreted. 

For example: Use “May 7, 2014” 

If the month is not spelled out, use the international date format of yyyy-mm-dd for 
consistency and ease of reference. 

For example: May 7, 2014 is noted as “2014-05-07” 

Use Accessible Tables and Charts 
Avoid tables and charts where possible but if they are required, format them to be 
accessible. 

When tables and charts are needed to make a large amount of information clear to 
readers, all of the basic accessibility considerations that are applied to documents must 
also be applied to tables and charts including appropriate font size, alternative text, and 
appropriate text alignment. 

Tips: 

 Ensure tables include column headings and where possible, just one row of 
headings. 

 Avoid using merged cells to keep tables simple. 

 If the table splits across pages, be sure to set the header to show at the top of 
each page. 

 Use formatting options to create different types of lines or apply textures rather 
than colours. 

Page 17 of 32 



    
 

   
 

    
  

 
 

     
 

   
 

  
 

    
 

     
 

 
 

   
 

   
 

   
 

   
 

    
 

   
 

     
 

 
   

 
     

 
 

 
  

  
  

 
     

   

Use Plain Language 

Use language consistent with Grade 7 or 8 reading level to ensure the largest number 
of people will understand the message. 

Plain language is a way of organizing and presenting the information so that it makes 
sense to the reader and is easy to read for the first time. 

Written material is in plain language if the reader can: 

 Find what they need to find. 

 Understand what they need to find. 

 Use what they find to meet their needs. 

Tips: 

 Write for your audience. 

 Use an active voice. 

 Use short sentences and paragraphs. 

 Use simple sentence structure and grammar. 

 Avoid the use of technical jargon. 

 Use simple, common everyday words. 

 Use full words such as “Street” instead of abbreviations such as “St.” and 
number instead of “no.”. 

 Use a positive tone. 

 Avoid the use of watermarks which create a distraction. 

Example: 

Original Language – Township of Brock residents who have limbs and debris 
from privately owned trees are asked to use the Region’s Waste Collection 
Program for their disposal needs. 

Plain Language – The Region has a Waste Collection Program. Use this 
system to dispose of limbs and debris from trees on private property. 
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Use Accessible Forms 

All forms placed on the Township website should be fillable. 

When possible, all forms placed online should be fillable to allow users to complete the 
information digitally without having to print the form and complete it by hand. 

Tips: 

 Organize the fields chronologically; 

 Ensure forms are keyboard accessible; 

 Make sure label and field locations are easy to use; 

 Make sure the information asked is short and basic; 

 Avoid using asterisks (*) to indicate a required field; 

 Offer standard entry fields for phone numbers; 

 Where a signature is required, ensure there is enough space; 

 Always start with a new template. 
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Accessible Document Checklist 

 Font Family (Arial) 

 Font Size (Minimum of 11) 

 Bold (no italics or underling for emphasis) 

 Upper Case Letters (no sentences with all upper case) 

 Text Alignment (align to the left) 

 Use Smart Headings, Paragraph, and Spacing Tools 

 Contrast (minimum 7:1 colour contrast) 

 Alt Tags (Alternative text) 

 Appropriate Leaders 

 Page Numbering 

 Date Format 

 Tables and Charts 

 Real Lists 

 Plain Language 

 Accessible Forms 
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Accessibility Checker 

The Accessibility Checker helps users create more accessible content. By identifying 
areas that might be challenging for users with disabilities, you can fix potential problems 
within your content. 

Accessibility Checker in Microsoft Word & Power Point 

This feature is available in Word 2010 and Power Point 2010 and above. 

1. Click on Info under the File tab. 

2. Click on ‘Check for Issues,’ then select ‘Check Accessibility’ from the drop down 
list. 

3. The Accessibility Checker pane opens. 

The Accessibility Checker checks your document against a set of possible issues. 
Each Issue that the Accessibility Checker finds is classified as an Error, Warning or 
Tip. 
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! 
Errors An Error is for content that makes a file very difficult or impossible for 

persons with disabilities to understand. 

Warnings A Warning is for content that in many, but not all cases, makes a file 
difficult for persons with disabilities to understand. 

Tips A tip is for content that persons with disabilities can understand, but that 
might be better organized in a way that would improve their experience. 

Fixing Accessibility Issues 

Whenever the Accessibility Checker finds an issue, the task pane shows the information 
about why the content might be inaccessible. When you select an issue, it shows you 
how to repair or revise it. 

Steps: 

1.Under errors, select a checker item and it will take you to 
that point in the document. 

2.Read the “Why Fix” section to understand why it should be 
fixed. 

3.Follow the “How to Fix” section to correct the issue. 

Page 22 of 32 



    
 

     
    

 
   

 

 

 

 

  
  
   
  

 
 
 
 
 
 
 
 
 
 
 

Accessibility Checker in ACROBAT (PDF) 
1. Save your source document as a pdf using the ACROBAT tab in the header 

2. Set document properties (File > Properties) 

Update the 

 Description 
 Document Title 
 Author (Township of Brock) 
 Keywords 
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3. Reading Order (Tools > Accessibility> Reading Order) 

Ensure the reading order is left to right top to bottom. To check click Page 1 and use the 
down arrow, this will take you through the reading order on each page. If you delete any 
empty change or change any order on the page, it will take you back up to the top of the 
page to check the reading order again. 

Like elements should be displayed in a single box. (If you have used the Styles built into 
the Source document, this will automatically populate) 
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4. Content Pane (Tools > Accessibility > Content) 

Ensure the content order matches reading order by selecting Page 1 and using the 
down arrow key to check the reading order. Any containers that are empty need to be 
tagged as artifacts. If you have used the styles built into Microsoft Word or Power Point, 
containers will be tagged automatically. 
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5. Tags Pane (Tools Accessibility > Tags) 

Ensure that the tags match reading and content order by clicking the down arrow. 
Follow along with the tags on the main document and delete empty tags. Ensure tables 
are tagged as tables. 

** If document contains external documents, not formatted by you at the source (which 
happens when you combine multiple files from internal and external sources), you will 
need to Auto Tag the document and add ALT text to each of the external document. 
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Re-check your Reading Order and Content order. 
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Checking Document Accessibility in Adobe 

Run a Full Check 
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The Accessibility Checker window will appear on the left hand side of the screen. 
Expand each header to ensure that section has passed. If there is an error If you are 
unsure of how to correct an error, right click the error and select explain rule. This will 
take you to the adobe website with an explanation 

 Reading Order needs to be manually checked, as this has been done in 
Step 2, you can right click and select Pass. 

 Colour contrast also needs to be manually checked. If using black text on 
a white background, you can right click and select Pass. 

 Primary Language needs to be set to English, right hand click, and set to 
English 

 If you have not set the Title, go into File (top left) and Properties and enter 
the title. Once fixed, right hand click Title and select Fix 
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The external documents in your file will be auto tagged as Figures. To add ALT Text 
right hand click Figure 1 and select Fix. 
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This ALT Text should contact the title of the external document, date, author and short 
summary. This description needs to be added for each external page. Use the same 
information and add Page 1 of X if there are multiple pages from an external source. 

To continue adding ALT text all figures in the document press the blue right facing 
arrow. When you have finished adding the ALT text click Save and close. 

Check the Reading Order again. The Auto Tag tool may have added tags to the source 
document as well. 

Resources 

The Accessible Digital Office Documents Project 

The Accessible Digital Office Documents Project provides information on creating 
accessible digital documents using the most popular office applications. 

Microsoft Word 2007 

Microsoft Word 2010 

Microsoft Excel 2007 

Microsoft Excel 2010 

Microsoft PowerPoint 2007 

Microsoft PowerPoint 2010 

Adobe Acrobat 10 Pro 

Adobe Acrobat 11 Pro 

Additional Information 

Learn more about the Accessibility for Ontarians with Disabilities Act and find free tools 
and resources 
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Township of Brock 

Request for Document in Alternate Format 

The Township of Brock is committed to meeting the needs of all residents. If you require information in 

an alternate format, please complete this form or contact the Clerk’s Department at 705-432-2355. 

Contact Information: 
Name: _____________________________________________________________________ 

Address: ___________________________________________________________________ 

Telephone Number: _____________________  Alternate Number: ______________________ 

E-mail Address: ______________________________________________________________ 

Preferred Method of Contact:  Mail  Phone  E-mail 

Document Information: 
Document Name: _____________________________________________________________ 

Section(s) Required: __________________________________________________________ 

Additional Document Information: ________________________________________________ 

Alternate Format Request 
 Large Print 

Font Size: _________Font Style: _________ 

 Electronic 

 Microsoft Word  HTML  Text  PDF 

 Colour Contrast 

 Other (please specify) 

Please return completed form to: 
Township of Brock – Clerk’s Department 

1 Cameron Street East, Box 10, Cannington, Ontario, L0E 1E0 

Email: brock@townshipofbrock.ca / Fax: 705-432-3487 

For Office Use Only: 
Date Received: ___________________________ Received By: __________________________________ 
Origin of Document:  Clerks Works  Finance  Fire  Building  By-law/Canine 
Action Taken: ____________________________________________________________________________ 
________________________________________________________________________________________ 
By Whom: _______________________________ Date Completed: _______________________________ 

NOTE: Personal Information on this form is being collected under the authority of the Freedom of Information and 
Protection to Privacy Act R.S.O. c.F.31, s. 39 (2) for the purposes of improving customer service. Questions about 
collection of personal information may be directed by mail to the address above. 

mailto:brock@townshipofbrock.ca
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